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Overview

These quick installation notes are to help you get started using VMware for Linux. Please 
go to http://www.vmware.com/support for more detailed and up-to-date technical 
documentation: 

Installing VMware 

Before you install VMware:

1. Make sure that glibc is installed on your host system.

2. Mount the VMware for Linux v1.0 distribution CD. 

3. Change to the ’vmware-distrib’ directory on the CD.

4. Become root by typing ’su’. 

To perform the installation:

1. Start the installation by typing ’./install.pl’

2. Exit from root.

3. Create $HOME/.vmware in your home directory.

4. License the product by copying the ’license’ file from the distribution CD to the 
’.vmware’ directory under your home directory.

Configuring Virtual Machines

1. If you are not already in your X server, type ’startx’

2. Launch VMware by typing “vmware” at the terminal prompt.

3. Select the VMware Configuration Wizard and follow the steps. 

The wizard guides you through the process of configuring your first virtual machine. 
See pages 7-9 for more detailed configuration help.

4. Save the configuration file.
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Installing and Configuring Guest Operating Systems

To install the guest operating system:

1. Power on your virtual machine.

2. Insert the install CD-ROM or floppies for the guest operating system. 

3. Follow the instructions provided by the operating system manufacturer. 

You will find detailed installation instructions for all supported Guest Operating 
Systems on our website at http://www.vmware.com/support/guestnotes.html

Optimizing your Installation

1. Install the VMware Tools inside the Virtual Machine. VMware Tools package 
includes an installation script, run it from inside the VM:

If your VM is running Linux: 

a) Insert and mount the VMware distribution CD in the VM’s CD-ROM drive.

b) Copy the ’/tools/vmware-tools142.tar.gz’ file to the VM’s disk.

c) Unpack the software by typing ’tar zxf vmware-tools142.tar.gz’.

d) Change to the ’vmware-linux-tools’ directory.

e) Install the product by typing ’./install.pl’

If your VM is running Windows 95, Windows 98 or Windows NT:

a) Insert the VMware distribution CD in the VM’s CD-ROM drive.

b) Double-click on ’vmt-win.exe’ from the CD’s /tools directory to begin the 
installation.

3. Install the VMware provided Optimized Host X server. By installing the VMware 
optimized XFree86 X servers you’ll notice significant improvements in full-screen 
graphics mode. We highly recommend that you install the VMware X server.

a) Identify the X server you are currently running on your host machine by 
checking the executable to which the ’X’ soft-link points. For example, on a Red 
Hat host, type ’ls /etc/X11/X’ and note which X server is being used.
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b) Go to /host-Xserver and identify the VMware provided host X server which 
corresponds to the X server being used.

c) Copy the VMware host X server to a directory on the host.

d) Change into the directory where you copied the VMware host X server and 
unpack the files by typing:

tar zxf <vmware-xserver>.tar.gz.

e) Refer to the README file in the directory which was created in the previous 
step, to finish installing the new X server.

See http://www.vmware.com/xfree86 for the latest X server versions

You will find a list of known problems in VMware for Linux 1.0 on the VMware website 
at http://www.vmware.com/support/releasenotes.html.

Using the Configuration Wizard

Starting the configuration wizard
When vmware is executed with no arguments, the startup screen has three options:

• Run the configuration wizard

• Run the configuration editor

• Open an existing configuration. 

If you are running... Use...

XF86_SVGA vmware-xserver-svga.tar.gz

XF86_Mach64 vmware-xserver-mach64.tar.gz

XF86_S3V vmware-xserver-s3v.tar.gz

XF86_3DLabs vmware-xserver-3dlabs.tar.gz

XF86_i128 vmware-xserver-i128.tar.gz

XFree86 server 3.3.3.1-3.4.3.diff patch
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The default selection is the configuration wizard.

1. Click "OK" to start the configuration wizard. 

The configuration wizard can also be started from the File menu (select 
File>Wizard).

Running the configuration wizard
The configuration wizard will present you with a series of screens that are navigated using 
the Next and Prev buttons at the bottom. At each screen, follow the instructions, and click 
on the Next button to proceed to the next screen. Each screen will ask you a question. 
You will either have to select an option or fill in some information.

There is also a Finish button, which is initially grayed out. When there is enough 
information for the configuration wizard to finish the configuration, then this button 
displays. Click on the Finish button to have the configuration wizard fill in all of the 
remaining options with default values. 

NOTE: Clicking Finish is the fastest way to configure your virtual machine.

Clicking on the Help button will open a pop up window with context sensitive help. That 
text will also include links to relevant online documents (text in blue - clicking on it will 
open a browser session and take you to that page).

Selecting an operating system
The first screen asks which operating system will be installed in the virtual machine. The 
configuration wizard uses this information to select appropriate default values, such as 
the amount of disk space needed. The wizard also uses this information when naming 
associated virtual machine files.

If the operating system you are using is not listed, select “Other” and give an appropriate 
name.

Selecting a directory for the virtual machine
For ease of administration, each virtual machine should have its own directory. All 
associated files, like the configuration file and the disk file, are placed in this directory. 

This screen lets you select the virtual machine’s directory. The default location is in 
vmware/<OS> in your home directory, where <OS> depends on the operating system 
previously selected. If you are configuring for Windows98, for example, the default 
directory will be vmware/win98.
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Virtual machine performance may suffer if your virtual hard disk is on an NFS mounted 
file system. You should make sure that the virtual machine’s directory is on a local file 
system.

Selecting the size of the virtual disk - (for new virtual disks) 
Fill in the size of the virtual disk that you wish to create. The size should be large enough 
to hold the guest operating system and all of the software that you intend to install in the 
virtual machine, with room for data and growth. There is no way to increase this number 
later, although you can install additional virtual disks if you run out of space on this one. 

The file which holds the virtual disk is not created at the maximum size of the virtual disk, 
but at a smaller size. This file grows as the virtual machine writes to the virtual disk.

Enabling the CD-ROM Drive
Select whether or not to allow the virtual machine to access the CD-ROM drive. If you 
wish to allow the virtual machine to access the CD-ROM device, the path to that device 
must be specified. This path is set to /dev/cdrom by default.

NOTE: Most operating systems will require the use of a CD-ROM for installation 
purposes. 

Even if the virtual machine has CD-ROM access enabled, access to the CD-ROM device 
can be disabled during the operation of the virtual machine using the Settings menu. This 
is useful if you wish to control which of several virtual machines that are running is 
allowed to access the CD-ROM. To control this, select Setting>Removable Devices.

Enabling the Floppy Disk Drive
Select whether or not to allow the virtual machine to access the floppy disk drive. If you 
wish to allow the virtual machine to access the floppy disk device, the path to that device 
must be specified. This path is set to /dev/fd0 by default.

Please note that some operating systems may require the use of a floppy drive for 
installation purposes.

Even if the virtual machine has floppy disk access enabled, access to the floppy disk device 
can be disabled during the operation of the virtual machine using the Settings menu. This 
is useful if you wish to control which of several virtual machines that are running is 
allowed to access the floppy disk. To control this, select Settings>Removable Devices.
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Configuring the networking capabilities of the virtual machine

The virtual machine can be configured to operate in a stand-alone mode, or it can be 
networked to the host machine, or it can be bridged to the real network (assuming the 
host is on a network). This screen lets you select the option that applies to this virtual 
machine. 

The No Networking option configures the virtual machine to be a stand-alone machine. 
In this case, the virtual machine has no networking support, like a PC with no network 
card.

The Bridged Networking option configures the virtual machine to have a network 
adapter, and this network adapter is connected to the host network card through a bridge. 
The bridge forwards packets from the host’s network interface to the virtual machine, and 
forwards packets from the virtual machine to the network interface of the host. This 
allows the virtual machine to appear like a real machine to other machines on the 
network. If this option is selected, then the virtual machine needs to be assigned an IP 
address, just like a real machine. DHCP can be used to do this automatically. 

The Host-only Networking option configures the virtual machine to have a network, but 
the virtual machine is visible only to the host machine on which the virtual machine is 
running, and not to other machines on the network. This is useful for sharing files 
between the virtual machine and the host machine.

See http://www.vmware.com/support/networking.html for more details about VMware 
networking options.

Saving your configuration
You will see a "Congratulations" window. This screen displays the configuration settings 
that you have selected, or which have been selected for you by default. 

If there are any errors in these settings, the Prev button will take you to the earlier screens, 
where you can modify these settings. 

Click Done to save the configuration and return to the main program window. 

To start the virtual machine you just configured, click Power On. 

NOTE: The configuration settings can be viewed and modified using the 
configuration editor, in the Settings menu (Settings>Configuration Editor).
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Installing Guest Operating Systems inside a VM

Windows NT Installation Guidelines
Windows NT 4.0 can be installed in a VM using the standard Windows NT CD. Before 
installing the OS, please make sure that you have already created a directory for the new 
virtual machine and configured it using the VMware Configuration Wizard (or Editor).

Windows NT Installation Steps 

1. Use the VMware Configuration Editor to verify the virtual machine’s devices are 
setup as you expect before starting the installation. For example, if you would like 
networking software to be installed during the Windows NT installation, make sure 
the VM’s Ethernet Adapter is configured and enabled.

2. Insert the Windows NT CD in the CD-ROM drive.

3. Power on the virtual machine to start installing Windows NT.

4. If you enabled the VM’s Ethernet Adapter, then an “AMD PCNET Family Ethernet 
Adapter” will be detected and set up automatically. The default settings should work 
fine and do not need to be changed.

5. Finish the Windows NT installation. VMware’s virtual disks support DMA transfers 
for better performance. The feature can be enabled after Windows NT has been 
successfully installed. You will need the NT Service Pack 3 or 4 CD to enable this 
option. Once the VM is running Windows NT, insert the SP3 or SP4 CD in the drive, 
run DMACHECK.EXE from the \SUPPORT\UTILS\I386 directory on the CD and 
click on the ’Enabled’ option for both IDE channels. 

After Windows has been installed, download and install VMware tools for improved 
video performance and added functionality.

Enabling Sound After Installing Windows NT

If sound was disabled during the Windows NT installation, it can be enabled after the OS 
has been installed. To setup the virtual machine to play sound, please follow the 
instructions at http://www.vmware.com/support/sound.html.

Enabling Networking After Installing Windows NT

If networking was disabled during the Windows NT installation, it can be enabled after 
the OS has been installed. To setup networking for a virtual machine, following the 
instructions below: 
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1. Shutdown Windows NT and Power Off the VM.

2. From the main program window, select ’Configuration Editor’ from the Settings 
menu and open the Ethernet Adapters panel.

3. Select a network Connection Type for the VM and click the Install button.

4. Save the updated configuration and Power On the VM.

5. When Windows NT reboots, open the Network properties page by double- clicking 
on the Network icon in Control Panel. Change to Network Adapters screen by 
clicking on the Adapters tab. Use the Add button and select the “AMD PCNET 
Family Ethernet Adapter” from the list. Use the default adapter settings, they do not 
need to be changed.

Windows 98 Installation Guidelines 
Windows 98 can be installed in a VM using the standard Windows 98 CD. Before 
installing the OS, please make sure that you have already created a directory for the new 
virtual machine and configured it using the VMware Configuration Wizard (or Editor).

Windows 98 Installation Steps 

1. Use the VMware Configuration Editor to verify the virtual machine’s devices are set 
up as you expect before starting the installation. For example, if you would like 
Windows 98’s Setup program to install a sound driver make sure that Sound is 
’Present’ in the VM’s config. 

2. Insert the Windows 98 CD in the CD-ROM drive. 

3. Power on the virtual machine to start installing Windows 98. 

4. Choose to ’Boot from CD-ROM’ then select the ’Start Windows 98 Setup from CD-
ROM’ option. The setup program will run FDISK and reboot. 

5. While the VM is rebooting and the message “Press <F2> to enter SETUP” is 
displayed at the bottom of the screen, tap the ESC key once. 

6. From the Boot Menu, use the arrow keys to select ’ATAPI CD-ROM Drive’ (even if 
you have a SCSI CD-ROM drive). 

7. Choose to ’Boot from CD-ROM’ then select the ’Start Windows 98 Setup from CD-
ROM’ option. The setup program will continue installing 98. 

8. Follow the Windows 98 installation steps as you would for a real PC. 

After Windows has been installed, download and install VMware tools for improved 
video performance and added functionality.
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Enabling Sound After Installing Windows 98

If sound was disabled during the Windows 98 installation, it can be enabled after the OS 
has been installed To setup the virtual machine to play sound, please follow the 
instructions at http://www.vmware.com/support/sound.html.

Enabling Networking After Installing Windows 98

If networking was disabled during the Windows 98 installation, it can be enabled after the 
OS has been installed. To set up networking for a virtual machine, following the 
instructions below: 

1. Shutdown Windows 98 and Power Off the VM. 

2. From the main program window, select ’Configuration Editor’ from the Settings 
menu and open the Ethernet Adapters panel. 

3. Select a network Connection Type for the VM and click the Install button. 

4. Save the updated configuration and Power On the VM. 

5. When Windows 98 reboots, it will auto-detect an “AMD PCNET Family Ethernet 
Adapter (PCI-ISA)” PCI Ethernet controller and prompt for the Windows 98 CD-
ROM to install drivers. The default Ethernet adapter settings should work fine and do 
not need to be changed. 

6. Use the Network icon from Control Panel to view or change network settings. For 
example, you may want to add the TCP/IP protocol since Windows 95 does not 
install it by default.

Known Issues with Windows 98

After Windows 98 has been installed you may notice COM5 and COM6 devices exist 
within the Windows Device Manager. These devices do not actually exist and are not 
consuming IRQ or other resources. You may remove them using the Windows device 
manager if you like. 

Support for EMM386.EXE and other memory managers is currently limited. If you will be 
initially booting using a customized non-standard MS-DOS or Windows 98 boot diskette 
make sure that EMM386.EXE (or other memory managers) are not being loaded. 
HIMEM.SYS and RAMDRIVE.SYS can be loaded and used without problems.

Windows 95 Installation Guidelines
Windows 95 can be installed in a virtual machine (VM) using a standard Windows 95 
boot diskette and CD-ROM. Some Microsoft Windows 95 OEM disks included with new 
computers are customized specially for those computers and include device drivers and 
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other utilities specific to the hardware system. Even if you can install this Windows 95 
operating system on your actual computer you may not be able to install it within a 
VMware virtual machine. You may need to purchase a new copy of Windows to install 
within a VM.

NOTE: Some Windows 95 distributions include instructions that do not include the 
steps to FDISK and FORMAT a C: drive. You must FDISK and FORMAT 
the VMware virtual IDE hard disk drives before running Windows 95 setup.

The instructions below are for the simplest case of one virtual IDE hard disk drive and 
one virtual IDE CD-ROM drive. If you have configured the virtual machine with more 
than one IDE hard drive, you should also FDISK and FORMAT these drives before 
installing Windows 95. If you have configured the VM with more than one virtual hard 
drive or one virtual CD-ROM you may need to use different device letters than in the 
instructions below.

Before installing the OS, please make sure that you have already created a directory for the 
new virtual machine and configured it using the VMware Configuration Wizard (or 
Editor).

Windows 95 Installation Steps 

1. Use the VMware Configuration Editor to verify the virtual machine’s devices are 
setup as you expect before starting the installation. For example, if you would like 
Windows 95’s Setup program to install a sound driver make sure that Sound is 
’Present’ in the VM’s config. 

2. Insert the Window 95 “CD-ROM Setup Boot Disk” in floppy drive A: and insert the 
Windows 95 CD in the CD-ROM drive. 

3. Power on the virtual machine. 

4. After the VM boots if you are presented with a choice of CD-ROM drivers, select the 
first IDE driver option available (even if your computer has a SCSI CD-ROM drive). 

5. Partition the virtual disk. Type: A:\> FDISK and answer the questions.

NOTE: If you create a primary partition which is smaller than the size of the hard 
disk, then make sure the partition is marked Active.

6. Reboot Windows 95: If the cursor is not already within the VMware window click in 
the window, then type CTR-ALT-DEL. If prompted on reboot to select a CD-ROM 
driver, select the first IDE CD-ROM driver from the list. 

7. Format the C: drive with; A:\> FORMAT C: /S 
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8. Now start the Windows 95 installation. Type; A:\> D:\WIN95\SETUP /IS

NOTE: An intermittent problem can occur during Windows 95 installations in a 
virtual machine. Shortly after the Windows 95 Setup program is started, 
scandisk runs to completion, and when the Windows 95 Setup program 
should start its graphical user interface, the VM returns back to an MS-DOS 
prompt. VMware recommends you reboot the computer and rerun 
Windows 95 Setup. You will not need to FDISK or FORMAT the drive 
again. If you can reproduce this problem please contact VMware customer 
support. 

9. If the VM’s Ethernet Adapter is enabled, you will have to manually add an Ethernet 
driver because Windows 95 will not detect it during the “Analyzing Computer” phase 
(even if you selected the Network Adapter detection option). Do the following to 
enable networking: 

a) Continue with the Windows 95 installation, until you get to the screen titled 
“Windows 95 Setup Wizard/Setup Options”. Change the default setting from 
’Typical’ to ’Custom’ and click the ’Next’ button to continue. 

b) From the screen titled “Network Configuration” (which appears after the 
“Analyzing Computer” phase), click the ’Add’ button, select the ’Adapter’ 
component, select “Advanced Micro Devices” from the manufacturer window 
and “AMD PCNET Family Ethernet Adapter (PCI&ISA)” from the network 
adapter window. 

c) If you need TCP/IP networking, add it from the ’Network Configuration’ screen 
(Windows 95 Setup does not enable TCP/IP by default). If you don’t do this, the 
first phase of the Windows 95 installation will not copy some of the files it will 
need later, and the entire installation will fail. 

10. Finish the Windows 95 installation. 

11. VMware’s virtual disks support DMA transfers for better performance. The feature 
can be enabled after Windows 95 has been successfully installed. To enable the 
feature: right-click on ’My Computer’ and select ’Properties’. From the System 
Properties dialog box click on the ’Device Manager’ tab, double-click the “Disk 
drives” device category, double-click the “GENERIC IDE DISK TYPE01” device, click 
on the ’Settings’ tab and enable the “DMA” check box. 

After Windows has been installed, download and install VMware tools for improved 
video performance and added functionality.
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Enabling Sound After Installing Windows 95

If sound was disabled during the Windows 95 installation, it can be enabled after the OS 
has been installed. To setup the virtual machine to play sound, please follow the 
instructions at http://www.vmware.com/support/sound.html.

Enabling Networking After Installing Windows 95

If networking was disabled during the Windows 95 installation, it can be enabled after the 
OS has been installed. To setup networking for a virtual machine, follow the instructions 
below: 

1. Shutdown Windows 95 and Power Off the VM. 

2. From the main program window, select ’Configuration Editor’ from the Settings 
menu and open the Ethernet Adapters panel. 

3. Select a network Connection Type for the VM and click the Install button. 

4. Save the updated configuration and Power On the VM. 

5. When Windows 95 reboots, it will auto-detect an “AMD PCNET Family Ethernet 
Adapter (PCI&ISA)” PCI Ethernet controller and prompt for the Windows 95 CD-
ROM to install drivers. The default Ethernet adapter settings should work fine and do 
not need to be changed. 

6. Use the Network icon from Control Panel to view or change network settings. For 
example, you may want to add the TCP/IP protocol since Windows 95 does not 
install it by default.

Known Issues 

1. After Windows 95 has been installed you may notice Unknown, COM5 and COM6 
devices exist within the Windows Device Manager. These devices do not actually exist 
and are not consuming IRQ or other resources. You may remove them using the 
Windows device manager if you like. 

2. Support for EMM386.EXE and other memory managers is currently limited. If you 
will be initially booting using a customized non-standard MS-DOS or Windows 95 
boot diskette make sure that EMM386.EXE (or other memory managers) are not 
being loaded. HIMEM.SYS and RAMDRIVE.SYS can be loaded and used without 
problems.
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Installing Other Guest Operating Systems
You will find detailed installation instructions on VMware’s website for the following 
additional guest operating systems:

1. Dos / Windows 3.1x

http://www.vmware.com/support/technotesdos.html

2. Red Hat Linux

http://www.vmware.com/support/technotesrh.html

3. Caldera OpenLinux

http://www.vmware.com/support/technotescaldera.html

4. SuSE Linux

http://www.vmware.com/support/technotessuse.html

5. FreeBSD

http://www.vmware.com/support/technotesfreebsd.html

VMware updates and adds to the support notes on a regular basis. Please make sure you 
visit http://www.vmware.com/support/guestnotes.html.

VMware Technical Notes

You will find a growing series of technical notes at http://www.vmware.com/support/. 
These notes include:

1. Installing and Compiling the VMware for Linux modules vmmon and vmnet

http://www.vmware.com/support/vmodules.html

2. Creating, configuring, and operating virtual machines (VM)

http://www.vmware.com/support/create.html

3. VMware networking support

http://www.vmware.com/support/networking.html

4. The different disk modes

http://www.vmware.com/support/rawdevices.html
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5. Configuring dual/multi boot systems to run with VMware

http://www.vmware.com/support/rawdevices.html

6. Creating hardware profiles within a virtual machine

http://www.vmware.com/support/hardwareprofiles.html

7. Installing an OS onto a Raw Partition from a Virtual Machine

http://www.vmware.com/support/osonpartition.html

8. VMware and sound

http://www.vmware.com/support/sound.html

9. Keyboard Mapping

http://www.vmware.com/support/keyboard.html

Troubleshooting 

Installation Issues
This section covers problems that may occur when running the install.pl script.

Q: I get the message “You must be root to install the VMware software”.

A: You must be operating as the superuser in order to have sufficient privileges to install 
the software. These privileges are needed, for example, to setup the VMware device 
drivers so that they are automatically loaded each time Linux is booted. To enable 
super-user privileges you should use the su(1) program; please consult that manual 
page. 

Q: I get the message “... stop: failed -- are you running a virtual machine?”

A: If you have VMware installed then you must shutdown any running virtual machines 
before running the install.pl script. If you cannot locate any virtual machines running 
on your system then check that there are no loadable modules in use by the operating 
system whose name begins with “vmmon” or “vmnet”. To do this become the super-
user and run the lsmod(1) command to list the modules presently loaded in the 
operating system. install.pl assumes that loadable modules with these names are part 
of the VMware software package. If you have modules with these names that are not 
from VMware then please file an incident online.
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Q: I cannot load vmmon because misc_register and misc_deregister cannot 
be resolved. This problem should only exist on 2.0.x kernels, not on 2.2.x kernels.

A: You MUST recompile your linux kernel to define CONFIG_UMISC. If you are using 
the graphical configuration tools (make xconfig), select Character 
Devices>Support for user misc devices modules

Q: I installed the software but did not configure networking support; how can I now 
enable this support? 

A: You must uninstall the software first and then re-install it from scratch. To uninstall 
the software run the install.pl script and answer no when prompted if you want to do 
an upgrade. You will then be asked if you want to uninstall the software; answer yes 
at that point. Then run install.pl again and this time enable networking support. 

Q: I installed host-only networking but the private IP network that I configured turns 
out to be in use; how can I change it? 

A: You have two choices. You can uninstall the software and then re-install it and 
reconfigure the host-only networking. Or, you can edit the file /etc/vmware/config 
and change the configuration parameters “vmnet.HostOnlyNetwork” and 
“vmnet.HostOnlyNetmask” to the intended values. 

CPU Issues
Q: I run the virtual machine and it fails at Power On time with the message “signal4” or 

“illegal instruction”

A: If you have a Cyrix 586 or older CPU then they do not support the RDTSC 
instruction (introduced with the Pentium Processor) and the VMware Virtual 
Machine will fail to Power On. If you check “/proc/cpuinfo” the flags line will say 
“tsc” if your CPU supports it. 

Performance Problems
Q: My virtual machine is very slow.

A: There is some overhead in running a guest operating in a virtual machine but the 
system should still be very usable. (Note that there is additional overhead in the beta 
distribution because the software is compiled to aid debugging and is not fully 
optimized for speed.) If your virtual machine is too slow to be usable check the 
following: 
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• Did you install the VMware Tools on the guest operating system? 

If not, then do this:

The VMware Tools package includes a display driver that has been optimized for 
the guest operating system running within a virtual machine. If this optimized 
driver is not installed then the guest OS will fall back to using a standard VGA 
device driver that is completely emulated in software and display performance 
will suffer dramatically. 

• Are you running in fullscreen mode or in a window? 

The best display performance is achieved when the virtual machine takes over 
the full screen. To switch to fullscreen mode you can either use the menu item 
View -> Full Screen or the appropriate hotkey for the virtual machine; e.g. Ctrl-
Alt-F8 for the first virtual machine started up.

• Did you assign a lot of memory to the VM and leave none for the host? 

It is possible to starve the host OS from having enough memory to operate 
efficiently by assigning too much memory to the VM. The host OS will be 
constantly swapping to disk if it can’t allocate a minimum amount of memory to 
itself; this in turn causes the VM to run slowly as well. When assigning memory 
for a VM, make sure to leave enough memory for the host OS to operate 
efficiently. 

• Is the VMware Linux process only getting a small (less than 10%) fraction of the 
host processor, even when the virtual machine is active? 

To figure this out run the top(1) program on the Linux host and look at the 
number in the %CPU column for your virtual machine (this process will either 
be named “vmware” or the name of your virtual machine configuration file; e.g. 
“nt4.cfg”). If you are not getting a significant fraction of the host processor then:

• Your host system configuration may be under powered; e.g. you do not have 
enough memory to run all the applications you want to run concurrently, or 

• Your virtual machine’s disk files (and any associated data structures such as 
“redo log files”) are mounted on a networked file system

Try running your virtual machine with all the data files resident on local file 
systems and with no other CPU-consuming applications. If that does not 
provide a usable system then run top and check if your system is insufficiently 
configured. You may want to reduce the memory size for your virtual 
machine(s) or add more physical memory to the host machine.
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• Is there a VM running DOS and idling? 

See the DOS idle notes on the DOS/Windows 3.1 installation page at http://
www.vmware.com/support/technotesdos.html.

• Is the guest operating system not on the list of supported operating systems; i.e. 
not one of DOS, Windows 3.11, Windows95, Windows98, Windows NT, Linux 
or FreeBSD? 

Unsupported operating systems may run very slowly, if they run at all.

Mouse Issues
Q: My mouse works fine in window mode but jumps around in full-screen mode.

A: You may need to specify the type of mouse you have. (Note that this is the type of 
your host’s mouse. The virtual machine always has a PS/2 mouse.) VMware normally 
gets the mouse type from your X server, but sometimes that is not possible or the 
information from X is incorrect. To specify the mouse type:

1. Start the configuration editor under the “Settings” menu. 

2. Go to the mouse panel by clicking on “Mouse”. 

3. Select the correct setting for “Host Mouse Type”. 

These mice are currently supported by VMware: 

• PS/2 mouse 

• Logitech MouseMan serial-port mouse 

• Microsoft serial-port mouse 

• Microsoft Intellimouse PS/2 

• Mouse Systems mouse

X Server Issues
Q: Why does VMware distribute its own version of the XFree86 X server?

A: VMware has extended the DGA (Direct Graphics Access) protocol. These extensions 
allow virtual machines to take advantage of the hardware graphics acceleration 
available on most graphics cards. 

Q: Are these changes proprietary?

A: No, these extensions are available in source and binary form. We hope that they will 
be integrated in the next release of XFree86 
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Q: I upgraded to the VMware X server, but now nothing works. 

A: Make sure that your graphics card is supported by XFree86 servers version 3.3.3.1. 
This is the most likely cause of this problem.

Q: I don’t run XFree86, but another type of X server.

A X servers other than XFree86 don’t support the DGA protocol. VMware will not be 
able to run in full-screen SVGA mode. Window-mode SVGA can be considerably 
slower then full-screen mode. Full-screen VGA is still available. 

Q: I don’t want to change my X server. Should I still install the VMware Tools?

A Yes, you should install the VMware tools in all cases. The VMware Tools contain an 
SVGA driver that enables high-resolution graphics to the virtual machines.   The 
SVGA driver also improves graphics performance even in window mode.

Q: Does VMware run over a network? 

A: Yes, VMware runs over a network with the X client (VMware) on a different machine 
from the server. This, however, can have a substantial performance impact.

Q: I got an error that my X server doesn’t support XKEYBOARD or XTEST. What is 
that about?

A: When you click or type into the virtual machine window, VMware takes over the 
keyboard and mouse to allow all input to go to the virtual machine. To make this 
transition work smoothly, VMware uses the X protocol extensions XKEYBOARD 
and XTEST. In addition, VMware uses XKEYBOARD to control the keyboard 
indicator lights (Caps Lock, etc.), so they can reflect the keyboard state of the virtual 
machine. If you are running an XFree86 server, XKEYBOARD may be disabled in the 
XF86Config file. Look for “xkbdisable” in /etc/X11/XF86Config, /etc/XF86Config, or 
/usr/X11R6/lib/X11/XF86Config. 
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CD-ROM Issues
Q: I cannot find a driver for the virtual machine’s CD-ROM

A: The mtmcdai.sys drivers works fine and it can be found on www.mitsumi.com: 
under Drivers and Manuals look for ide158.exe. You will need to add the following 
modification to the config.sys and autoexec.bat files on your boot floppy (along with 
the mscdex.exe file):

     config.sys
     DEVICE=HIMEM.SYS
     DOS=HIGH
     FILES=30
     rem install cd-rom driver
     DEVICE=A:\MTMCDAI.SYS /D:VMware

     Autoexec.bat
     @ECHO OFF
     PROMPT $p$g
     A:\MTM\MSCDEX.EXE /D:VMware /M:10 

Sound Issues In The Host
Q: When I enable sound, I get the message ‘The PCM sound device is not available 

(dev/dsp: Device not configured).’

A: To make the sound device available to the VM, you must first configure your host 
machine for sound. On Red Hat, the program ‘sndconfig’ (which must be run as 
root) will probe for known devices and configure your kernel according to what it 
finds, without requiring a reboot. In other cases, please refer to the instructions 
specific to your host OS to configure sound. Several sound cards are not supported 
by Linux. If you have one of them, you will not be able to play sound in the VM, even 
if the guest OS supports that card.

The dialog box also gives you the option of emulating the device without having 
sound support in the host OS (the “No Sound” button). In this case the VM will have 
a virtual sound device, but you won’t hear anything. 

Q: I get this message: ‘The PCM sound device is not available (dev/dsp: Device or 
resource busy)’.

A: Some other program is using the sound device. You must quit that program first. 
Virtual Machines can share the sound device. If another VM is currently using it, 
simply terminate the application that is producing sound. Only one VM at a time can 
actively use the device. At Power On, the device must be unused. 
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Q: I get this message: ’The PCM sound device is not available (dev/dsp: Device or 
resource busy)’.

A: Enlightment Sound Daemon is running and using the sound device. You can use the 
ESD’s esddsp wrapper to start the VMware virtual machine’s configured for sound. 
Start the VMware virtual machine by typing ’esddsp vmware’ or ’esddsp 
<config_filename>.cfg’. The wrapper will pass the sound output generated by the 
VM as an audio stream to the ESD audio server. 

Q: I get this message: ’The PCM sound device is not available (dev/dsp: <some other 
error message>)’.

A: There may be a problem with the sound driver in the host OS. In some cases, 
rebooting or removing the sound modules (with the ‘rmmod’ command) and 
reinstalling them (with ‘insmod’) fixes the problem. The names of the modules to be 
removed and reinstalled are specific to each sound card model. 

Sound Issues In The Guest
Q: Such-and-such sound application works well at times, poorly at other times. 

A: Sound is sensitive to system load. Shutting down or pausing other applications may 
help.

Q: Such-and-such application produces terrible sounds or no sound at all, or aborts or 
behaves in other weird ways when trying to use the sound device.

A: Sound support is experimental. Don’t use that application, or use it with sound 
turned off if possible.

Advanced Power Management (APM) Issues
Q: When I try to suspend the system, Windows tells me that some driver or program is 

preventing me from suspending. What should I do?

A: If you have a freshly installed Windows 95/98, try again after installing VMware’s 
SVGA driver via the VMware Tools program. The default graphics adapter prevents 
the system from suspending. If you already have the SVGA driver installed, then it’s 
likely to be some application program that is running. Try selectively stopping 
utilities that are running in the right end of task bar. 

NOTE: If all else fails, you can get a utility called “pmtshoot.exe” from the Microsoft 
support web site (http://support.microsoft.com) that can be used to 
troubleshoot problems with suspending the system under Windows 98. 
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Windows 95 Installation Issues
Q: Why is it that during the Windows 95 install process certain networking files can’t 

be located on the CD and how can I recover from these errors?

A: Windows 95 does not detect the VM’s Ethernet Adapter during the Analyzing 
Computer phase of the installation and therefore does not copy the associated driver 
files from the CD to disk. After the first reboot, Windows 95 auto-detects the VM’s 
Ethernet Adapter but can’t find the associated files on the disk; furthermore, 
Windows 95 can’t access its own CD because it has not loaded a CD-ROM driver at 
this point! To fix the problem do the following: 

1. Click the Skip File (or Cancel) button to continue with the Windows 95 installation. 

2. After Windows 95 boots for the first time, networking won’t work correctly. To fix 
the problem, open the System Properties dialog by double-clicking on the System 
icon in Control Panel. 

3. Click on the Device Manager tab and open the Network adapters folder. 

4. Delete any references to an AMD Ethernet adapter or other entries with a yellow “!” 
next to them. 

5. Click OK to close the System Properties dialog. 

6. From the Control Panel, double-click on the Network icon to open the Network 
dialog. 

7. Click on the Add button, select Adapter from the list of network components and 
click Add again. 

8. From the Manufacturers window select “Advanced Micro Devices” and from the 
Network Adapters window select the “AMD PCNET Family Ethernet Adapter 
(PCI&ISA)” card. 

9. Click OK to install the drivers (the Windows 95 CD will be needed to copy the files to 
the virtual machine’s disk). The drivers should be installed and Windows 95 will have 
to reboot.

VMwareToolbox Issues
Q: When I change an option such as “Auto Grab” does it affect only the current VM or 

all VMs?

A: Changes to the VMwareToolbox options are global per-user. The options are saved 
in the per-user preferences file when a VM powers off. The options are read by each 
VM when they power on.
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Q: I accidentally exited VMwareToolbox on Windows. How do I restart it?

A: You can restart it from the start menu.

Q: I only get the mouse auto grabbing, auto releasing, cut & paste, etc. after I log in to 
the guest OS. Why is this?

A: VMwareToolbox is not started until you log in. Until you log in, you will have to use 
the hot keys to release the cursor and click in the window to grab the cursor. Features 
such as cut & paste will not be available. 

Miscellaneous Issues
Q: The file system containing /tmp is filling up. Is it possible to have VMware store 

temporary files somewhere else?

A: By default VMware uses /tmp for storing temporary files. VMware also honors the 
Linux environment variable TMPDIR. You can set this to point to another directory 
location, which must be writable by the user. For example, to specify ’vmware’ should 
use /usr/local/tmp from the bash shell and type:

    export TMPDIR=/usr/local/tmp

or from the csh type:

    setenv TMPIDR /usr/local/tmp

More Help

Check Help Topics

Click on Help in the VMware for Linux Graphical User Interface.

Visit the website

VMware’s website has an extensive support section with many technical notes that are 
updated often.

Visit the Newsgroups

VMware Newsgroups are at news.vmware.com. 

Newsgroups are primarily forums for customers to help each other.
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Quick Answers

Check the FAQ

Find Frequently Asked Questions and corresponding answers on VMware’s website.

Search the website

VMware’s website has a search engine and an extensive support section that is updated 
often. 

http://www.vmware.com/support

VMware, Inc.
3145 Porter Drive, Bldg. F
Palo Alto, CA 94304
http://www.vmware.com

http://www.vmware.com/support
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